Contents

1. Dynamic VDP Overview ..................................................................................................................... 4

2. How to convert a static design to variable job .................................................................................. 5
   2.1 Tutorial: Converting a static design to a variable job ................................................................. 5

3. The Dynamic VDP Database .............................................................................................................. 10
   3.1 A Database file .............................................................................................................................. 11
   3.2 Counters ..................................................................................................................................... 11
      3.2.1 Simple Counters .................................................................................................................. 12
      3.2.2 Database Driven Counters ................................................................................................. 12

4. The Dynamic VDP palette: Dynamic Objects .................................................................................... 14
   4.1 Dynamic VDP Properties ............................................................................................................. 15
      4.1.1 Position .............................................................................................................................. 15
      4.1.2 Rotation ............................................................................................................................ 16
      4.1.3 Color .................................................................................................................................. 17
   4.2 Dynamic Text ................................................................................................................................ 20
      4.2.1 Creating a VDP text object ............................................................................................... 20
      4.2.2 Text Properties ................................................................................................................... 21
      4.2.3 Fields .................................................................................................................................. 21
   4.3 Dynamic Barcodes ......................................................................................................................... 22
      4.3.1 Barcode properties ............................................................................................................... 23
   4.4 Dynamic Images ............................................................................................................................. 24
      4.4.1 Creating a new VDP Image object ....................................................................................... 24
      4.4.2 Image Properties .................................................................................................................. 24
      4.4.3 Different file types for Dynamic Images .............................................................................. 29

5. Checking and expanding a VDP file .................................................................................................. 31
   5.1 Expand .......................................................................................................................................... 31
   5.2 Preflight ....................................................................................................................................... 32
   5.3 Rules ............................................................................................................................................. 32
      5.3.1 Database Rules .................................................................................................................... 33
      5.3.2 Object Rules ........................................................................................................................ 35
   5.4 The Dynamic VDP Log ................................................................................................................ 38
      5.4.1 Filter ....................................................................................................................................... 39
   5.5 Record Sets .................................................................................................................................... 40
   5.6 Expanding on a server ................................................................................................................... 40
      5.6.1 Exporting a Variable Data Template .................................................................................... 41
      5.6.2 Creating a VDP job from a Variable Data Template ............................................................ 41

6. Tips and limitations ............................................................................................................................. 42
6.1 Illustrator File Compatibility ........................................................................................................ 42
6.2 PowerLayout Client Import Assistant .......................................................................................... 42
6.3 Known limitations ....................................................................................................................... 43
6.4 Performance tips ......................................................................................................................... 43
1. Dynamic VDP Overview

Dynamic VDP plugin is a tool to create variable documents (e.g. labels) where each label can be different. Dynamic VDP combines static content (that is identical on all labels) with variable texts, barcodes and images. The values for these variable objects are specified in a database. The whole workflow has three main steps:

1. Design the variable document
2. Expand (i.e. generate the individual labels)
3. Step and Repeat the labels, and RIP

Designing a variable document is done using the Dynamic VDP plugin.

Expansion can be done directly in Dynamic VDP plugin or on a server. When special Illustrator text features are used (such as text on a path, text in a complex path or text with a shadow), expansion can only be done in Illustrator. Expansion on a server however is much faster and it can handle bigger jobs: it is e.g. not recommended to expand significantly more than 10000 labels in Illustrator, while a server can handle databases of any size.

Step and repeating and RIPing is always done on a server.

**Typical workflow**

- Design a **static label** containing all elements, using normal (static) text, barcodes or images.

- Convert the static design to a **variable** one. Open the database, and link objects with the corresponding database fields.

- **Preview** the design (label) for several database records, and make the necessary adjustments (font size, exact position, ...)

- Optional: define **Database Rules** or **Object Rules**. Preflight and check for errors.

- **Expand** directly in Adobe Illustrator or export a template to the server and expand on the server

**Processing the result of the Expansion**

The result of expanding is a PDF/vt file (or multiple PDF/vt files when expansion is done on the server). PDF/vt is a ISO standard for storing variable documents. It is a special optimized version of multipage PDF file where the static content is stored only once and reused on all pages. It can be handled like any other multipage PDF files, but Esko server tools such as Step and Repeat and RIP, are optimized to handle it better than normal multipage PDF files.
2. How to convert a static design to variable job

This chapter will explain how to convert a label design into variable one.

The first thing you need is a label design itself.

The design should be ready for print production, including correct overprint settings, inks, sufficient bleed area and trapping. All barcodes should be created by the DeskPack Dynamic Barcodes plug-in.

The second thing you need is a correct database file which contains all the data for variable objects. The most common format for database exchange is CSV file format, eg. created in Microsoft Excel.

The result will be a multipage PDF/VT file which can be viewed by a PDF viewer or sent to a server for further processing. It is highly recommended to use Adobe Acrobat to check the file as other viewers might not handle the PDF/VT file correctly.

2.1 Tutorial: Converting a static design to a variable job

In this tutorial, we will convert a static design to a variable job. The files needed can be found in the Samples Files folder

On Mac the "Sample Files" folder can be found in the installation package (inside the .dmg file) or DeskPack installation disk, on Windows please see \[Installation Folder]\bg_data_DynamicVDP_v010\Sample Files. By default the Installation Folder is C:\Esko

1. Open Salmon2012.ai from the Samples folder
2. Select Window > Esko > Dynamic VDP to open the Dynamic VDP palette.
3. Click Select a database in the Dynamic VDP palette

   The Select Database palette allows you to define the source of the database. It can either be a database file or a sequence of numbers called “Counter”. See The Dynamic VDP Database on page 10
4. Click **No file. Click here to specify database file**
The Select database file will open, in which you can select the database file, database encoding and field separator. The default values should cover the majority of cases.

5. Click **Browse** to select *Salmon2012_ExampleDatabase_500.csv* from the Samples folder
After selecting a CSV file, field names are now listed with their first records in the Select Database palette. Using the Preview controls, you can inspect the database. The Rules allow to define the database checking features.
6. Click OK.

The Dynamic VDP palette is now enabled. The Record Set drop-down list can be used in case database checking features are involved. Preview controls are useful in case some variable objects are correctly defined.

7. Select the QR bar code in the top left corner (created by the Dynamic Barcodes plug-in), and click the Convert to VDP object button in the VDP Objects palette.

The Dynamic VDP palette will show this first variable item, and the Dynamic VDP Properties shows several parameters of the selected object. See Dynamic VDP Properties on page 15.
8. In the **Dynamic VDP Properties**, in the **Code** field, select all leading zero's and click the **Dynamic Field** button.

9. In the **Insert Field** dialog, select the "id_code" field, and click **Insert**.

The zeros in the Dynamic VDP Properties are replace by \[id\_code\] which represents the variable inserted from the database.
10. Repeat the two previous steps to replace "John" and "Doe" by the database items "FirstName" and "LastName"

11. Now it is time to create some variable text. Select the text object "Imported and smoked for John Doe".

12. Click the **Convert to Universal Text** button to make the object variable. The line of text will now appear in the Dynamic VDP plugin, and its properties are shown in the Dynamic VDP Properties.

13. Select the text "John" in the Dynamic VDP Properties palette, and click **Insert/Modify**

14. In the **Insert Field** dialog, select "Database" and "FirstName", and click **Insert**. Repeat the same to replace "Doe" by database item "LastName".

Both the QR barcode and text are now variable. You can check this by browsing through different records, using the arrow buttons in the **Dynamic VDP** palette. You can see the QR barcode and the text will change according to the selected record.

15. Choose **Start Expansion** from the contextual menu of the Dynamic VDP palette to create a PDF/VT document. Define name and location, and click **OK**

The generated PDF/VT file can be viewed in Adobe Acrobat. It will contain one page for every record in the Database, using the corresponding variables in the QR barcode and text line.

In Adobe Illustrator, the **Dynamic VDP log** will show all warnings and errors.
3. The Dynamic VDP Database

To make a job variable, a source of variable information is needed. This is set in the Select Database dialog. Click Select a database in the Dynamic VDP palette (only if no Database is set yet), or choose Select Database in the fly-out menu of the Dynamic VDP palette.

**Database**

In Dynamic VDP you can either use a Database File or a Simple Database.

A Database file is used in case the job should contain complex information such as names, serial numbers or links to images.

See A Database file on page 11 for more info on the Database file.

When using a Simple Database, you only use Simple Counters, and don’t need a Database file. This is suited for jobs that only require a simple sequence of numbers.

You can define how many records need to be generated in the Number of records field.

**Data Preview**

The Record Set offers functionality to limit the set of records used. This is also available in the Dynamic VDP palette. See Record Sets on page 40.

The Preview allows to select what record will be used for preview, both in the Dynamic VDP palettes as in the Adobe Illustrator file. You can use the arrows to navigate through the records. You can easily
jump to the first or last record by clicking an arrow button while holding the Control key. This is also available in the **Dynamic VDP** palette.

**Database Fields**

If a Database File is selected, this section will show the available Field Names, and the corresponding value for the record selected in **Data Preview**

You can apply **Rules** and **Global Rules**. See **Database Rules** on page 33

**Counters**

You can click the **Add** button to add a new Counter, click **Edit...** to modify the selected Counter, or click **Remove** to delete it.

If you use a Database File, you can add Database Driven Counters and Simple Counters. When using a Simple Database, you can only use Simple Counters

See **Counters** on page 11 for more info on Counters.

### 3.1 A Database file

Database files must be saved in CSV file format. This format is supported by many database engines and office tools like Microsoft Excel.

An example of the CSV format is provided below:

<table>
<thead>
<tr>
<th>id_code, name</th>
</tr>
</thead>
<tbody>
<tr>
<td>4859323, Libor Šindlar</td>
</tr>
<tr>
<td>8529512, Michal Polanský</td>
</tr>
<tr>
<td>7418529, Milan Arnošt</td>
</tr>
<tr>
<td>9874561, Milan Brunclík</td>
</tr>
</tbody>
</table>

Values in a CSV file are separated by a delimiter. This can be a space, a tab, a comma or a semicolon.

The first line of a CSV file by default defines the database field names. Field names are case sensitive, so you can have both a field "Name" and "name".

**Note:** Only uppercase and lowercase ASCII letters, digits and underscores can be used in the field names.

You can also use a database split into a header file and a database file, but only if

- the header file contains only a single line with database field names
- the amount of field names corresponds to the amount of columns used in a database file
- the Header and database file use the same delimiter and text encoding

### 3.2 Counters

Counters allow to add a sequence of numbers to the job.

- A **Simple Counter** is a simple sequence of numbers, without the need for a database file. See **Simple Counters** on page 12
• When using a Database file, you can create a **Database Driven** counter, which uses database records as input for the counter. See **Database Driven Counters** on page 12

### 3.2.1 Simple Counters

A **Simple** counter will generate a sequence of numbers based on the first value, step and eading zeros.

![Add Counter dialog](image)

The **First Value** can be any numeric value, and is used as first value in the sequence.

The **Step** defines the number added to the previous value. Eg. a step of 5 will give a sequence such as 0, 5, 10, 15, ...

**Note:** A negative step is not allowed

If **Leading zeros** is enabled, zeros will be added to the numbers in the sequence.

- When set to **Automatic**, leading zeros are added so that every number in the sequence has the same amount of digits as the highest number. For example a sequence going up to 200, will result in 001, 002, 003, ..., 010, 011, ..., 199, 200.

- When set to **Minimum counter length**, leading zeros will be added so that every number in the sequence has at least the amount of digits defined here. For example the same sequence, with a minimum counter length of 4 will result in 0001, 0002, 0003, ..., 0010, 0011, ..., 0199, 0200. In this case, numbers above 9.999 would not get any leading zero.

### 3.2.2 Database Driven Counters

Using Database driven Counters allows to take a numerical value from a database and perform simple mathematical operations or add leading zeros.
1. Select the **Variable** from the Database file you want to use. Obviously, it only makes sense to select a numeric variable.

2. Set the **Step**. The value of the Variable will be multiplied by the step.

3. Set the **Base Value**. The Base Value will be added to the result of the previous calculation.

4. Define the **Leading zeros**. Only **Minimum counter length** is available for Database driven Counters: leading zeros will be added so that every number in the sequence has at least the amount of digits defined here.

Example:

- **Step** is set to 3
- **Base value** is set to 1500
- **Leading zeros** is set to a Minimum counter length 5

If the selected Variable has a value "12", the counter value will be "01536"
4. The Dynamic VDP palette: Dynamic Objects

The Dynamic VDP palette can be opened by choosing \texttt{Window \> Esko \> Dynamic VDP \> Dynamic VDP}. The Dynamic VDP palette lists all variable elements and allows to browse through a database.

If no database is selected, the palette is disabled. You can click \texttt{Select a database} or choose \texttt{Select Database} in the fly-out menu to open the \texttt{Select Database} palette. See \textit{The Dynamic VDP Database} on page 10.

After a database is selected and some objects are created, the palette will show all Dynamic VDP objects.

The \texttt{Record Set} offers functionality to limit the set of records used. This is also available in the \texttt{Select Database} palette. See \textit{Record Sets} on page 40.

The \texttt{Preview} allows to select what record will be used for preview, both in the Dynamic VDP palettes as in the Adobe Illustrator file. You can use the arrows to navigate through the records. You can easily jump to the first or last record by clicking an arrow button while holding the Control key. Preview is also available in the \texttt{Select Database} palette.

The palette gives an overview of all Dynamic objects. The icon indicates the type of Dynamic VDP object, while the name of the object is constructed from its type and actual text content. A blue square on the right side indicates if the object is selected in the Adobe Illustrator file. A single click will select a Dynamic Object in the list, double-clicking will select the object in the Adobe Illustrator job.

The \texttt{Details} section shows information about the Dynamic VDP job, about the currently selected Dynamic VDP object and about the currently previewed record.

The \texttt{Convert to Universal Text} button \begin{figure}[h] \centering \includegraphics[width=0.4\textwidth]{convert_to_universal_text.png} \end{figure} will convert the selected text to Universal Text. See \textit{Dynamic Text} on page 20.
The **VDP Properties** button opens the **Dynamic VDP Properties** palette. Properties of Dynamic VDP Object selected in the document will be shown immediately. See **Dynamic VDP Properties** on page 15.

The **Select** button selects the highlighted Dynamic VDP object in the Adobe Illustrator job.

The **Convert to VDP Object** button will transform selected object into Dynamic VDP Object or Named Object. See

- **Dynamic Text** on page 20
- **Dynamic Barcodes** on page 22
- **Dynamic Images** on page 24

Named Objects can be used to position Dynamic VDP Objects. See **Position** on page 15

### 4.1 Dynamic VDP Properties

The Dynamic VDP Properties shows the properties for the currently selected Dynamic VDP object. There are some common properties for every Dynamic VDP object:

- **Position** on page 15
- **Rotation** on page 16
- **Color** on page 17

There are also properties depending on the type of Dynamic VDP object that is currently selected. See

- **Text Properties** on page 21
- **Barcode properties** on page 23
- **Image Properties** on page 24

At the bottom of the dialog, you can define Object Rules. See **Object Rules** on page 35

#### 4.1.1 Position

The position of a Dynamic VDP object is based on 3 settings:
**Attach to**

The position of the Dynamic VDP object can be based on

- the Trim Box
- the Media Box
- another Dynamic VDP object
- Named Art

Named Dynamic Art is any art in your Illustrator document, that you gave a name in the Layers palette, and converted to a Dynamic Object: browse to the object you want to name in the Layers palette, double click the default name (eg. <path>) and enter a name. Next, click the **Convert to Dynamic VDP Object** button.

**Positioning**

The way the Dynamic VDP object is attached, can be chosen by clicking and dragging the blue square (representing the Dynamic VDP object) to the desired position on the grey square (representing the **Attach To** reference). Each square has 9 reference points (top left center and right, middle left center and right, and bottom left center and right), so you have 81 different ways of positioning the Dynamic VDP object.

In the example underneath, the top center of the (bounding box of the) Dynamic VDP object will be placed on the left bottom corner of the (bounding box) of the reference defined in the Attach to field.

---

**Note:** If you create a Dynamic VDP object from an existing object, the Positioning settings (the blue rectangle) will be automatically set, using the smallest offset possible while keeping the object at the same location.

**Offset**

In the offset fields, you can move the Dynamic VDP object based on the defined position. The direction of the offset is down/left, as shown by the arrows.

**Note:** You can also manually move Dynamic VDP objects. In that case, the offset will automatically adjust to the new location. The other settings (Attach To and Positioning) will NOT change.

---

4.1.2 **Rotation**

The value for rotation can be defined either by using the buttons or by typing custom values in to the text field. Negative values are supported.

You can also manually rotate Dynamic VDP objects. In that case, the rotation value will automatically adjust.
Note: Since rotation changes the bounding box of the selected Dynamic VDP object, the offset values (which are based on the bounding box) in the Position will be updated.

4.1.3 Color

As defined by Illustrator

In most cases, Dynamic VDP object use the color settings As defined by Illustrator.

Each change performed by the Adobe Illustrator tools is automatically reflected. You can also apply specific formatting on a selected part of a text string. However, formatting applied on a first character of a variable string will be applied on the rest of the string.

Process Color

By choosing Process Color you can define the color of the Dynamic VDP object. The selected color will be applied on the complete Dynamic VDP object. You can define the color in a CMYK, CMYKOV or CMYKOVG ink set.

1. Set Color to Process Color
2. Click the Select Color button
3. Select the **Ink Set** you want to use: CMYK, CMYKOV or CMYKOVG

4. Define the color by setting the ink percentages. You can enter constant percentages, or define the ink percentage using variables from the database by clicking the blue square button next to ink percentage value. Obviously, the selected database fields should only contain numbers between 0 and 100.

5. Click **OK**

The resulting color will be shown next to the **Select Color** button, along with the ink set used.

**Named Color from Database**

Using **Named Color from Database** you can change the color of a Dynamic VDP object by using the entries of the database file to select the correct Swatch defined in the Adobe Illustrator document.

1. Set **Color** to **Named color from Database**

2. Choose the **Database Field** you want to use in the dropdown menu

3. Choose **Check Colors from Database** from the fly-out menu of the **Dynamic VDP** palette. A dialog will open, informing you about the number of swatches found in the Database that don't exist yet.
4. Click **Yes**. A new group “VDP” is added to the Swatches palette

5. For each unique record, a new swatch is created inside the “VDP” group, using a black color. Double-click them to open the **Swatch Options** dialog and adjust the settings.

Dynamic VDP is now set to color the Dynamic VDP object using the database entries

**Tip:** Do not forget to apply the **Check Colors from Database** function when the database file is changed.
4.2 Dynamic Text

The most common way to make a job variable is to change some text or number on every label/page. Dynamic Text can be a combination of static and variable strings inside a text object.

**Note:** Dynamic VDP was made to fit the needs of the label market. No advanced direct mail features are provided.

Adobe Illustrator offers 3 types of text objects:

- Point Text
- Area Text
- Text on Path

These text objects can be converted to two types of variable texts.

**Adobe Illustrator Text**

- All the features provided by the Adobe Illustrator text engine can be applied on this type of text.
- Adobe Illustrator effects like warping or drop shadow are available for variable text strings.
- Text object must be expanded by Adobe Illustrator.
- Expansion on the DFE is not supported.

**Universal Text**

- This type of text offers all the mandatory text formatting features. Advanced features like Tracking or Kerning are not supported.
- You can define font, size and color of a text string. Rotation is supported as well.
- The text objects can be expanded by Adobe Illustrator, at a higher performance than for Adobe Illustrator Text.
- Expansion on the DFE is supported.
- Text on Path is not supported for Universal Text.
- Text inside a complex path (e.g. star) is also not supported for Universal Text. Rectangular shapes are supported only.

### 4.2.1 Creating a VDP text object

1. Create the appropriate text objects, using Adobe Illustrator's text tools, and select it.
2. Make the text Dynamic, by converting it to a VDP Object, or to Universal Text
   - Converting to Universal Text will increase performance, but exclude some graphic features (such as a drop shadow effect). To do so, click the **Convert to Universal Text** button.
• When converting to VDP Object (Adobe Illustrator Text), you will have lower performance than with Universal Text, but all graphic features are supported. To do so, click the Convert to VDP Object button.

**Note:** It is possible to convert Adobe Illustrator text to Universal Text, but not the other way around.

3. Use the **Dynamic VDP Properties** to modify the properties of the newly created Dynamic VDP text object.

### 4.2.2 Text Properties

Text formatting of a Dynamic VDP Text object can be done using the default Adobe Illustrator tools, but text content can be changed in the **Dynamic VDP Properties** only.

Position, rotation and color properties are default Dynamic VDP Properties. See *Dynamic VDP Properties* on page 15

The content of the Dynamic VDP text object is visualized in the **Text** field. It is the only place where content changes can be made. Variables are visualized in square brackets and can be inserted or modified only by the **Insert/Modify** button.

Use the **Rules...** button to define rules for the Dynamic VDP object. See *Object Rules* on page 35

Use the **Insert/Modify...** button to insert a new Variable or (in case one single variable is selected when clicking the button) to edit an existing one. For more information on defining Variable Fields, see *Fields* on page 21

### 4.2.3 Fields

Some input text boxes provide support for so called **Fields**. Fields are acting as placeholders for variable strings which will be inserted from the selected database.
Insert Field dialog can be opened either by clicking the *Insert / Modify* button or by clicking ![Insert Field dialog](image).

The dialog provides access to database fields, counters and predefined values.

The predefined values are:

- `vdp_index`: the number of the current record
- `vdp_index_1k`: the number of the current record divided by 1 000
- `vdp_db_size`: the total number of records in the database

### 4.3 Dynamic Barcodes

Variable information encoded in a barcode is another popular way to make a job variable.

The classic 1D barcodes provide a simple way to transfer included information to a computer, using a special barcode reader.

Modern 2D barcodes are optimized to contain a lot of information on a small area. Smartphones equipped with a camera and appropriate software can read this information and act accordingly.

Dynamic VDP provides support for a wide range of 1D and 2D barcodes, about 50 in total. The vast majority of barcodes created by the Dynamic Barcodes plug-in is supported by Dynamic VDP. Only the PZN and PZN8 barcodes are not supported.

To create a VDP Barcode, select a barcode created by the Dynamic Barcodes plugin, and click the **Convert to VDP Object** ![Convert to VDP Object](image) button.
4.3.1 Barcode properties

Formatting of a Dynamic VDP barcode can be done using the default Adobe Illustrator tools. Additional parameters like symbol size, bar width reduction or error correction can be modified in the Dynamic Barcodes panel, but the content of the code can be changed in the Dynamic VDP Properties only.

Position, rotation and color properties are default Dynamic VDP Properties. See Dynamic VDP Properties on page 15.

The code of the Dynamic VDP barcode object is visualized in the Code field. It is the only place where the code can be changed. Variables are visualized in square brackets and can be inserted or modified only by the Insert/Modify button.

Use the Rules... button to define rules for the Dynamic VDP object. See Object Rules on page 35.

Use the Insert/Modify... button to insert a new Variable or (in case one single variable is selected when clicking the button) to edit an existing one. For more information on defining Variable Fields, see Fields on page 21.

Remarks on barcodes

- Rotating a barcode can reduce its readability. Try to limit the rotation of barcodes to 0, 90, 180 or 270 degrees.
- For a good readability, you should pay attention when defining the colors for a barcode: a high contrast between the background and the color used in barcode cells is recommended.
- Some of the barcodes can accept binary and decimal input. Dynamic VDP offers only one option. Check the dialog for the code in order to insert correct form of input string.
- Although some GS1 barcodes in the Dynamic Barcode plugin can accept a composite component, this feature is not supported by Dynamic VDP.
4.4 Dynamic Images

Using Dynamic VDP you can set up variable images. Dynamic VDP contains a set of features that allows you to place images with a variable size and aspect ratio into a design with certain dimensions and possibly a different aspect ratio.

A Variable image can also be used place output of a 3rd party application, for example a special barcode symbol saved either as raster or vector based image.

4.4.1 Creating a new VDP Image object

1. If you need to place a new image, choose File > Place and make sure the Link option is enabled.
2. If you want to use an already placed image, check if the image is Linked.

You can check if an image is linked (instead of embedded):

- In the Links palette, an embedded image has an icon next to its name.
- In the Layers palette, the name of an embedded image will by default be <Image> while for linked images, this will be <Linked File>.

In case the image is embedded:

a) Select the image, and open the Link palette.
b) Choose Relink... from the fly-out menu of the palette.
c) Select the image to be used, enable the Link checkbox, and click Place.

3. In the Dynamic VDP palette, click the Convert to VDP Object button.
4. Use the Dynamic VDP Properties to modify the properties of the newly created Dynamic VDP image object.

4.4.2 Image Properties

Some of the properties can be modified using Adobe Illustrator tools and some of them by the VDP Objects Properties only.

Position and rotation are default Dynamic VDP Properties. See Dynamic VDP Properties on page 15.
Use the **Size** dropdown to define the **target area**, the rectangle in or on which the dynamic Images will be placed during expansion. See **Size** on page 25

**Note:** You can use the Adobe Illustrator tools to interactively change the position or size of the target area. Changing the size will be reflected in the settings.

Use the **Fit** settings to define how the dynamic images are fitted in or on the target area. See **Fit** on page 26

Define the **Images** to be used: the root path and file name. See **Image** on page 29

Use the **Rules...** button to define rules for the Dynamic VDP object. See **Object Rules** on page 35

**Size**

The **Size** drop-down list provides different options to define the size of the images.

**Custom Size**

**Custom Size** is the default option for newly created Dynamic Images. The **Vertical** and **Horizontal** settings define the absolute dimension for the target area, and images are fit onto the target area, using the **Fit** settings. See **Fit** on page 26.

When converting an image to a Dynamic VDP object, the size of the original image is used.

Working with **Custom Size** (when using uniform scaling) will always give a more or less predictable size of the images. The scaling used will depend on the size of the images.
Note: In case the Dynamic VDP Object is selected, the target area is shown as a green rectangle. However, if the currently selected image fits the target area in both directions, the green rectangle will be hidden by the borders of the image.

Custom Scale
When using Custom Scale, you define a fixed scaling. The size of the images will depend on the size of the input images.

Setting the scaling to 100% vertical and horizontal, will place every input image at its original size. By entering a different value for horizontal and vertical scaling, you can apply non-uniform scaling. In this case, the Size settings are not used.

Fit to Object
When using Fit to Object, the selected object is used as Target area, and the input images are fit on that target area, using the Fit settings. See Fit on page 26

The Object can be the Trim Box, Media Box or another Dynamic Object (Dynamic Text, Dynamic Barcodes, Dynamic Images or Named Dynamic Objects). You can not use the Dynamic Object itself.

Named Dynamic Art is any art in your Illustrator document, that you gave a name in the Layers palette, and converted to a Dynamic Object: browse to the object you want to name in the Layers palette, double click the default name (eg. <path>) and enter a name. Next, click the Convert to Dynamic VDP Object button.

Shrink to Fit
Shrink to Fit works the same as Fit to Object but will only downscale the images, it will not enlarge them.

Fit
The Fit setting offers four way to fit the image to the target area. In the example images underneath, an image with aspect ratio 4:3 will be placed in a target area with aspect ratio 2:3.

• Uniform is the default option. The image will be scaled as big as possible to fit the target area, while maintaining the aspect ratio.
• **Non-Uniform**: the width and height of the image will fit the target area. The image aspect ratio is not preserved, so the image will be distorted.

• **Fit Width**: The width of the image will fit the width of the target area. The image aspect ratio is preserved, and the height of the image may exceed the target area.

• **Fit Height**: The height of the image will fit the height of the target area. The image aspect ratio is preserved, and the width of the image may exceed the target area.
Note:
Keep in mind that, when using "Fit Width" or "Fit Height", the image can be higher resp. wider than the target area. In some cases (e.g. when placing a portrait image to a landscape area, see the example underneath), the image might exceed the target area a lot.

Positioning
The Positioning diagram defines the position of the Dynamic VDP object inside the document. See Position on page 15 The Positioning diagram combines the alignment (eg top right) of the Dynamic VDP Object, on anchor points (e.g. bottom left corner) on the trim box (or other reference object). The selected alignment is also used for positioning the Dynamic Image inside its area (but for this, the "anchor point" is disregarded):

- **Fit Width**: the vertical alignment of the Dynamic VDP object is used: top, center or bottom.
- **Fit Height**: the horizontal alignment of the Dynamic VDP object is used: left, center or right.
- **Uniform**: either vertical or horizontal, depending on the scaling.
Example: Using **Fit Height**: the Dynamic VDP object is set to align the bottom center of the object, on the top left of the Trim box. The image will be aligned centered on the area.

Image

In the **Image** settings, you define where and how to find the image files.

The path to the image is divided in two parts: the **Root Path**, which is the static part of the file path, and the **Name**, defining the name (including variables) of the image and its suffix.

By default the Root Path will show the path to the original linked image, and the Name will show the original image name and suffix.

You can change the Root Path by clicking the path, and browsing to the Root Path folder.

Use the **Insert/Modify...** button to insert a new Variable or (in case one single variable is selected when clicking the button) to edit an existing one. For more information on defining Variable Fields, see **Fields** on page 21.

Using these **Fields** you can set up a variable image name, or even define in what (variable) subfolder an image is. When defining a subfolder, use a backslash (\) when running on Windows, and a forward slash (/) when running on Mac.

Example: if the **Name** is set to `[model]/[color].png`, and if a record has value "ModelA" for model, and "Blue" for color, the image "Blue.png" will be taken from the subfolder "ModelA" inside the defined root folder.

### 4.4.3 Different file types for Dynamic Images

The **type** of a Dynamic Image is set when creation it, based on the original image. During expansion, all variable images should be the same type as the Dynamic Image.

It can be either:

- multichannel raster, for example a CMYK JPG file
- single channel raster, for example a grayscale or bitmap TIFF. You can use the Dynamic VDP **Color** properties to color a grayscale or bitmap image. See **Color** on page 17
- PDF

**Raster images**

For raster images, these file formats are supported:
• TIFF
• JPEG
• PSD
• PNG

PDF

Vector based images must be provided as PDF files up to version 1.7 (Normalized PDF or Adobe PDF).

Color space is not limited to CMYK only, as Grey, Bitmap, RGB or LAB are supported as well.

It is possible to use a multipage PDF. The Page input field allows to select the page to be used. By applying a Variable field in this input field (see Fields on page 21), you can apply different pages during expansion. Keep in mind that Expansion will fail if the requested page does not exist.

Note: Adobe Illustrator will always display the first page of the PDF. Only after Expansion, the correct page is shown.
5. Checking and expanding a VDP file

To produce a variable job out of Adobe Illustrator, you have to **Expand** the job. By doing so, a PDF/VT file is created when expansion finishes without any error. See **Expand** on page 31

**Preflight** allows to check if the Variable job can be expanded, but no output is generated. It can warn you in advance whether there are some issues in the job. See **Preflight** on page 32.

The possible issues and how severe they are is defined in the **Database Rules** and **Object Rules**. See **Rules** on page 32.

When dealing with a complex design and/or a big database, where expanding can be very time consuming, it might be recommended to Preflight first: Preflight runs through the complete database and collects information about all issues found, while Expansion is canceled when a first error is encountered.

If for example you have a big database, with two records (e.g. record 1000 and record 2000) that cause an error, Expansion will error and stop after record 1000. Then you would have to fix this first error, and restart expansion. When the second error is reached, expansion will stop again after expanding 2000 records, so you have to fix the second error, and restart the expansion all over again. When Preflighting, you will get an overview of all errors in one go, without having to restart Expansion after fixing every error.

After checking or expanding, you can limit the set of records used, to get quicker access to records that require attention. See **Record Sets** on page 40

**Note:** You can use **Check Database**... to do a quick check of the database. It does NOT expand any Dynamic VDP objects, so a successful Database check does not guarantee successful expanding. For that, you need to do a **Preflight**.

5.1 Expand

Expansion will create a PDF/VT file. This file contains all the fonts and images, and can be easily send for further processing.

1. Open a valid Dynamic VDP file in Adobe Illustrator. You might want to add Database Rules or Object Rules to check during expansion. See **Rules** on page 32
2. Select **Start Expansion**... in the fly-out menu of the **Dynamic VDP** palette
3. Select the output folder and name for the PDF/VT file, and click **Save**.

The suffix -vdp.pdf is automatically added to the file name.

During the output a progress bar is shown. You also get an indication of the total number of records, the record currently expanding, and the amount of errors and warnings.

**Note:** The progress bar might give unreliable results when expanding Adobe Illustrator text, or when running Dynamic VDP in Adobe Illustrator CS5.
5.2 Preflight

Preflight allows a fast overview of all issues related to the job. No PDF/VT is generated, but list of all found issues is provided.

1. Open a valid Dynamic VDP file in Adobe Illustrator. You might want to add Database Rules or Object Rules to check during preflight. See Rules on page 32

2. Select Start Preflight... in the fly-out menu of the Dynamic VDP palette

   During the output a progress bar is shown. You also get an indication of the total number of records, the record currently expanding, and the amount of errors and warnings.

3. You will get a message indicating if errors were found during the preflight. Click OK

   The Dynamic VDP Log palette will open, summarizing the found issues. See The Dynamic VDP Log on page 38

4. Double-click any of the issues to open the properties of the corresponding rule, to check the error.

5.3 Rules

As the output of a dynamic VDP job often contains many thousand labels, it is not feasible to inspect them manually. Problems in database such as missing entries, invalid entries, duplicates, ..., or problems of VDP objects such as text too long, missing check digit for bar codes) would not be noticed.

Rules were introduced to automatically check (and in some cases fix) errors in the database entries.

Database rules are optional, and check individual values or complete records from the database. Database rules do not take into account where the fields are used, since e.g. the customer name could be used both in a text or in a bar code. Using Database rules you can check if a value is empty, the number of characters, what characters are used, duplicity, etc.

Object rules are set for individual VDP objects.

Different VDP objects can have different rules, for example a VDP Image can have a rule to check if the image file can be loaded, while VDP text can have a rule related to the used fonts. As the content of VDP text or barcode usually contains one or more database fields, the string related rules (empty
value, number of characters, allowed characters, ..) are also available there. Note that for Object rules the complete input string, consisting of several static and variable parts, is taken into account.

Some of the Object rules, such as checking for empty values, are optional. Other Object rules are always active: the application always needs to know what to do in case of a missing image or using non-existing glyphs in a font.

Rules are checked during expansion and during preflight, and any issues will be reported. If the severity of a rule is set to "error", expansion will be stopped when the first violation of the rule is encountered, while preflighting will continue and report all errors.

### 5.3.1 Database Rules

By applying Database Rules, you can discover possible issues which may appear during processing. The Database file might contain entries that can cause problems to the design or contain invalid values, such as entries that are too long, or duplicate records. Specifying some boundaries or allowed values for database fields can help to identify possible problems.

You can set **Global Rules**, applied across all fields in the Database, or **Field Rules**, which are only applied on the selected field.

#### Actions for a Database Rule

For every Rule you set, you can define what to do when the rule is violated:

- **Error**: the error is logged, and processing of the job is canceled
- **Warning**: a warning is issued, but processing will continue
- **Replace**: the original value is replaced by the defined replacement value, and processing will continue without any warning.
- **Warning and Replace**: the original value is replaced by the defined replacement value, a warning is issued, and processing will continue.

**Note**: The available actions depend on the selected rule

#### Global Rules

**Global Rules** are applied across all fields in the Database. You can set a Global Rule by clicking the **Global Rules**... button in the **Select Database** dialog.
Duplicates found in records checks whether all records are unique. Two records are unique if all their fields are identical. If at least single field is different the records are also different.

Duplicates found in subsequent records checks whether subsequent records are unique. Two records are unique if all their fields are identical. If at least single field is different the records are also different.

Field Rules

Field Rules are applied on a specific field in the Database. You can set a Field Rule by selecting a field, and clicking the Set Rules... button in the Select Database dialog.

The Current result column will show the result of the individual rule(s) for the currently selected record. At the bottom of the dialog, the Current value is shown, along with the overall result (error, warning) for all defined rules.

There are two groups of Field rules: Size and Content

Size

- Select Empty value to check whether this field has any empty values. If you select Ignore whitespace characters, spaces and other typographic symbols will be treated as empty values. By choosing "Replace" or "Warning and Replace", you can set to replace the empty value by what you enter in the by field.
- To check for values that may be too short, select Minimum length is, and enter a number of characters. Values shorter than this will fail the check.
- To check for values that may be too long, select Maximum length is, and enter a number of characters. Values longer than this will fail the check.

Content

- Select Duplicates found in values to check if the selected field has the same value in two different records in the database.
- Select Duplicates found in subsequent values to check if the selected field has the same value in two subsequent database records.
- You can check whether the field's values match a certain regular expression. You can use this for example for barcode values, serial numbers, or phone numbers.
• An example could be to use this regular expression: \d\+\d\[\s\d\]* to check phone numbers. This means the value must start with a plus sign and a digit, followed by only digits or spaces.

• Use the Value can contain only list to limit the types of characters that are allowed in the field’s values.
  • Latin characters (a-z and A-Z), either only Uppercase, only Lowercase or both (“Any”)
  • Digits
  • Special symbols (for example + ! > $ &).
  • Non latin characters (Å¼ Åœ)

Checking a Database

Once some rules are defined, you can check the current Database file.

The Database file is checked automatically when running a Preflight or Expansion (including when the expansion is done on a server, since the rules are included in the VDT template). See Expanding on a server on page 40. The result of the check is shown in the DynamicVDP Log. See Checking and expanding a VDP file on page 31 for more info on Preflight and Expansion.

However, by choosing Check Database... from the fly-out menu of the Dynamic VDP palette, you can manually check the Database.

Note: Check Database... only does a quick check of the database. It does NOT expand any Dynamic VDP objects, so a successful Database check does not guarantee successful expanding. For that, you need to do a Preflight. See Preflight on page 32

Note: The Check Database... option is not available if no Database file is selected yet, or if a Simple Database is used.

The result of the database check is first reported by a message. In case some issues were detected the DynamicVDP Log palette is opened.

5.3.2 Object Rules

Using Object Rules you can check the content or placement of specific Dynamic VDP objects.

To apply a Rule on an object, select the Dynamic VDP object, and click the Rules button in the Dynamic VDP Properties palette.

Unlike database field rules, Object rules are not limited to a single database field, and they can check a combination of several variables and static text strings.

As object rules are linked to concrete Dynamic VDP object, they can be more specific and check validity like "is number 123456 a valid entry for EAN 13 barcode?" or "is john.jpg a valid image?"

The available rules depend on the selected Dynamic VDP object.

Note: Object rules are included in a VDT template, and will be examined during expansion on a server. Expansion might be cancelled based on the selected action in the rule.
The **Current result** column will show the result of the individual rule(s) for the currently selected object. At the bottom of the dialog, the **Current value** is shown, along with the overall result (error, warning) for all defined rules.

For every Rule, the same actions as for a Database Rule are available. See *Actions for a Database Rule* on page 33

**Actions for an Object Rule**

For every Rule you set, you can define what to do when the rule is violated:

- **Error**: the error is logged, and processing of the job is canceled
- **Warning**: a warning is issued, but processing will continue
- **Skip**: the specific Object is not generated, and processing will continue without any warning.
- **Warning and Skip**: the specific Object is not generated, a warning is issued, and processing will continue.
- **Replace**: the original value is replaced by the defined replacement value, and processing will continue without any warning.
- **Warning and Replace**: the original value is replaced by the defined replacement value, a warning is issued, and processing will continue.

**Note**: The available actions depend on the selected rule

**Text Rules**

**Note**: Some of the available rules are the same as the Database Rules. However, the Object Rules check the complete input, which can be the combination of one or more variables and static parts.

### Size

- **Empty value, Minimum length** and **Maximum length** are the same as the Database Field Rules. See *Size* on page 34
- Select **Object outside Trim Box** to check if the object is placed inside the trim box area.
- The **Safe Margin** allows to define the threshold from the Trim Box.
  - a positive value means a "safe margin" is kept on the inside of the Trim Box
  - a negative value allows objects that are slightly outside of the Trim Box
  - The Safe Margin uses the unit set in the Adobe Illustrator Document Settings
- **Text Overset** is only available for Area Text and Text on Path, and not for Point text. It checks if the contained text can be fitted in to the given area or path.
- **Text fitting** is only available for Universal Area Text. Two aspects can be checked:
  - **Text fits into single line** allows to check for unwanted line breaks, e.g. in an address, required to stay on 3 lines.
  - **Text fits into text box** is useful for bigger texts with long paragraphs. It will check if the last line of the text is still within the text box.

Text fitting rules can provide an error or a warning. By clicking the **Fit text size ...** you can also set an automatic fix. There are two options:
• **If Scale text horizontally** is selected, the text will be condensed, without going below the defined Minimum value for horizontal scale. The advantage of this method is that the font maintains the same height, and the position of the individual lines is not changed. Small horizontal scaling is also less visible for reader. This option is recommended in combination with **Text fits into single line**. Notice that if the text was already condensed, it will not be condensed below the specified threshold.

• **Change font size.** is applied after scaling (when both are active). You can specify the Minimum font size. This option is recommended in combination with **Text fits into text box**. If different parts of the text uses different fonts and font sizes, all used fonts are scaled down by the same factor.

If you select **Notify when text size is changed**, you get an indication how many times and for what records the font size was adjusted.

• Using **When fitting the text is not possible** you can decide what to do if the text is too big, even after scaling and changing the font size: either generate a warning (and continue), or generate an error (and stop expansion).

**Content**

All available rules are the same as the Database Field Rules. See **Size** on page 34

**Fonts**

**Note:** The **Fonts** rules cannot be disabled.

• The **All fonts are available** rule checks whether all fonts used in the selected text objects are available.

• The **All Characters are available** rule check whether all characters used in given text objects are available in the font used.

**Barcode Rules**

• Select **Code is available** to check whether this field has any empty values. If you select **Ignore whitespace characters**, spaces and other typographic symbols will be treated as empty values. By choosing "Replace" or "Warning and Replace", you can set to replace the empty value by what you enter in the by field.

• The **Check digit is specified** rule checks whether the barcode input contains a valid check digit. Obviously, this is only available for barcodes that require a checkdigit (e.g. EAN13). If the check digit is not defined and the rule is not active, the check digit is computed and added silently. If the rule is active, it can be set to "warning" or "error": "error" will stop the expansion, while "warning" will compute the check digit and generate a warning

**Note:** If the check digit is specified but it is wrong, this will always result in an error (and expanding will stop).

• Select **Object outside Trim Box** to check if the object is placed inside the trim box area.

• The **Safe Margin** allows to define the threshold from the Trim Box.

  • a positive value means a "safe margin" is kept on the inside of the Trim Box
  • a negative value allows objects that are slightly outside of the Trim Box

• The Safe Margin uses the unit set in the Adobe Illustrator Document Settings
Image Rules

- **The Image Is Available** rule checks if the referenced image exists on the specified path.
- **The Image Type is Supported** rule checks whether the referenced image can be imported and applied.
- **Select Object outside Trim Box** to check if the object is placed inside the trim box area.
- **The Safe Margin** allows to define the threshold from the Trim Box.
  - a positive value means a "safe margin" is kept on the inside of the Trim Box.
  - a negative value allows objects that are slightly outside of the Trim Box.
- The Safe Margin uses the unit set in the Adobe Illustrator Document Settings.

5.4 The Dynamic VDP Log

The Dynamic VDP Log palette lists issues generated by the Dynamic VDP plug-in. It can open automatically after Expansion or Preflight, or can be opened by choosing **Window > Esko > Dynamic VDP > Dynamic VDP Log**.

The table shows:
- an icon showing the severity of the issue
- the name of the Dynamic VDP object
- the number of the record where the issue was detected.
- the message indicating the actual issue.

You can select an entry in the palette and click **Show** or double-click the entry to preview the issue.

**Note**: Rule settings are opened when showing or double-clicking database issues.

From the fly-out menu of the Dynamic VDP Log palette, you can
- apply a **Filter** on the log entries. See **Filter** on page 39
- select **Remove Filter** to remove the currently applied filter.
• **Clear Issues**: all issues listed in the palette are removed

• **Save Report**: an HTML report containing all currently listed issues is saved. This can be used e.g. to submit to the database provider, requesting to solve all listed issues.

### 5.4.1 Filter

1. In the Dynamic VDP Log palette, choose Filter ... from the fly-out menu.

   The Select Filter dialog will open

2. Set the first condition for log entries to be shown

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severity</td>
<td>show the log entries of which the Severity is or is not</td>
</tr>
<tr>
<td></td>
<td>• Error</td>
</tr>
<tr>
<td></td>
<td>• Warning</td>
</tr>
<tr>
<td></td>
<td>• Database Issue</td>
</tr>
<tr>
<td></td>
<td>• Database Error</td>
</tr>
<tr>
<td></td>
<td>• Database Warning</td>
</tr>
<tr>
<td></td>
<td>• Object Issue</td>
</tr>
<tr>
<td></td>
<td>• Object Error</td>
</tr>
<tr>
<td></td>
<td>• Object Warning</td>
</tr>
</tbody>
</table>

3. By default, Condition 2 is set to Disabled. If you want to filter based on a combination of two conditions, you can set the relation for Condition 2. This defines whether log entries should be shown if they match both conditions (and) or any of the conditions (or).

   a) Select and if log entries should be shown if they match both conditions

   b) Select or if log entries should be shown if they match (at least) one of the conditions

   c) Set up Condition 2 the same way you set up Condition 1
4. Click **OK** to apply the filter

You can see a filter is applied as the bottom line in the Dynamic VDP Log dialog will no longer show the total number of errors and warnings found, but also the amount of errors and warnings shown from the total amount, e.g. "$filtered 771 of 771 errors and 0 of 898 warnings$".

By choosing **Filter ...** from the fly-out menu again, you can modify the filter.

By choosing **Remove Filter** from the fly-out menu, you can remove the currently applied filter.

---

5.5 Record Sets

By default, the Dynamic VDP uses all records from the selected database file or simple databases. However, using the **Record Set** functionality, you can limit Dynamic VDP to only use a restricted set of records. This can be used to get quick access to records which might require attention.

The **Record Set** dropdown is available in the **Select Database** palette, and in the **Dynamic VDP** palette.

By default, this is set to **All Records**.

After a **Database Check**, you can limit the set to **Records with database problems**. See for more information on database check.

After a **Preflight** or **Expand**, you can limit the set to

- **Records with database problems**, since preflighting and expansion always includes a database check
- **Records with preflight errors and warnings**
- **Records with preflight warnings**
- **Records with preflight errors**

See [Checking and expanding a VDP file](#) on page 31 for more information on Expansion and Preflight.

After using the function, you can also limit the set to **Suspicious Records**.

The **Create Suspicious Record Set** function, available from the fly-out menu of the **Dynamic VDP** palette, creates a set of records that might require attention. It will contain:

- the longest string for every column
- the shortest string for every column
- the longest value among all columns
- the shortest value among all columns
- the longest record
- the shortest record

---

5.6 Expanding on a server

The Dynamic VDP plug-in can export a **Variable Data Template** to be sent to and processed by a server.
The template is generated by the Dynamic VDP plug-in. It allows to expand a job on a server which provides faster processing thru parallel expansion.

The Variable Data Template contains all the graphical elements. The Database file and variable images (if any) are not included.

### 5.6.1 Exporting a Variable Data Template

To export a Variable Data Template:

1. Use Adobe Illustrator and the Dynamic VDP plug-in to create a Variable Data job
2. Define Rules and their severity. Rules are checked on the server, when the Database file and the Variable Data job are combined. See Rules on page 32 for more info on Rules.
3. Choose Export Template... in the fly-out menu of the Dynamic VDP palette.
4. Select the output folder, and click OK

A Variable Data Template file (.VDT) will be generated.

**Note:** It is not possible to import a Variable Data Template back into Illustrator. It is highly recommended to keep the native Adobe Illustrator files for future modifications in the templates.

### 5.6.2 Creating a VDP job from a Variable Data Template

To create a VDP job from a Variable Data Template file:

1. Start the DFE Client
2. Choose File > New Print Job...
3. Click Browse..., select the VDT file, and click OK
4. Define the Step and Repeat parameters in the automatically opened dialog, and close the dialog to create the Print Job
5. Open the Print Job Properties
6. In the Files tab, define the database

**Note:** A Simple Database must be defined in this dialog as well

7. Set the path to the variable images (if applicable)

**Note:** The folder containing the images should be located in the prepress share of the DFE

8. In the Step & Repeat tab, modify the variable data filling if needed.

The job is now ready to be processed.
6. Tips and limitations

6.1 Illustrator File Compatibility

Illustrator files containing Dynamic VDP settings are backward compatible, so you can open files generated by older versions while preserving Dynamic VDP settings and editability of variable objects.

However, when you are trying to open a file generated by newer version of Adobe Illustrator, you get a message stating you can import the file, but some data loss might occur. If you continue the import, all variable objects will be converted to static objects, and all properties will be lost.

**Saving files to be compatible with older versions of Illustrator**

In Adobe Illustrator you can save the file in legacy file formats, by setting the **Version** while doing a **Save as** to Adobe Illustrator format. Files saved using this procedure will handle dynamic objects properly.

**Note:** Although this procedure will preserve Dynamic VDP objects, other Illustrator version specific objects still might be modified or lost.

6.2 PowerLayout Client Import Assistant

To convert multiple XML files to Adobe Illustrator files and SRT templates:

2. Make sure that no document is opened.
3. Open the **PowerLayout Standalone** palette.
4. Go to its contextual menu and choose **PowerLayout Client Import Assistant**.
5. Follow the on-screen information to convert multiple XML files to AI files and SRT templates.

**Note:** Do not work with more than 100 XML files at once in order to avoid having Illustrator crash.

**Note:**
- PowerLayout Client Import Assistant should work with batches of up to 100 XML files.
- PowerLayout Client Import Assistant progress is not reported properly: Illustrator can go to a "not responding" state while the conversion is still running. In this case, it is recommended to check the output folder, where new AI or SRT files should appear.
6.3 Known limitations

**Expansion: Maximum number of records**

The biggest issue for expansion is the memory used by Adobe Illustrator. Since memory usage is influenced by variable elements (barcodes require more memory than universal text) and complexity of fixed part of the job, it is not really possible to define a fixed maximum number of records that can be expanded from the Illustrator.

When using Adobe Illustrator Dynamic Text (see Dynamic Text on page 20) is limited to 10,000 records.

A Job using Universal Text can go further, up to 50,000. The actual limit depends on the used file.

It is highly recommended to expand jobs with images or high volume or records using a 64-bit version of Adobe Illustrator and sufficient amount of RAM (e.g. 8 GB or more).

**Text formatting**

Adobe Illustrator text is generated by the Adobe Illustrator text engine, while universal text is created by Esko text engine.

Although those two text engine behaves almost identical in basic features (e.g. font face, size, color), some differences may occur in advanced text features like line spacing, tracking, kerning, etc.

The preview shown in Adobe Illustrator uses the correct text engine, so it reflects the behavior of expansion. Every unwanted behavior will be immediately visible to user. In some cases a warning message is issued.

**Note:** When a text object is being edited by the Text Editing tool of Adobe Illustrator, the text is shown in "Edit View". When in Edit View, the text will be rendered by the Adobe Illustrator text engine. This means that when starting or ending editing Universal Text, small differences might occur.

**Resizing and rotating Dynamic VDP objects**

In some cases, you can resize Dynamic VDP objects using Adobe Illustrator tools. However, in some cases (e.g. resizing area text by dragging), Adobe Illustrator behaves differently when working with native Adobe Illustrator objects or with Dynamic VDP objects.

To avoid this, it is recommended to change dimensions and rotation of Dynamic VDP objects using its properties panel.

**Clipping masks**

Adobe Illustrator allows to define clipping masks on objects. However, Expansion will ignore clipping masks on Dynamic VDP objects.

6.4 Performance tips

- **Text**: it is highly recommended to use Universal Text instead of Illustrator Text. Processing of Universal Text is much faster when expanding using Illustrator or server.
• **Document Structure:** If possible, put all variable objects on a separate, top-most layer. Although the Expand function can process jobs where static objects are placed on top of variable ones, this will cost some time.

• **Transparency:** Any kind of transparency, opacity or PostScript overprint applied to a variable object will slow down Ripping. If possible, it is recommended to keep variable objects opaque (which is the default settings in Adobe Illustrator).

• **Barcodes:** Some barcodes, e.g. QR barcodes, allow to set a "correction level". This improves the readability when the barcode is damaged, but it requires more time to compute and create such barcode. It is recommended to keep such settings on default values.